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Introduction 
This manual will help guide you through the setup and calibration of your DBX mass airflow meter 
from Abaco Performance.  This new mass air meter represents a number of technological 
advancements over other similar products which are often repurposed factory sensors in different 
housings.  The DBX meter is a multi sensor digital air measuring device that allows for installation in 
virtually any orientation due to its design. Thanks to a completely user configurable circuitry which 
allows for 10 unique output calibrations, the DBX is an extremely versatile meter with almost limitless 
applications. 

Engine load measurement 
There are a number of ways that modern engine management systems measure load in order to 
provide correct fueling for proper engine operation.  Commonly used strategies include Speed 
Density, Alpha-N, and Mass air.   

Speed Density systems utilize an intake manifold pressure sensor along with a number of other 
sensors to “guess” at how much air has entered the engine for determination of load.  This system is 
commonly seen in aftermarket engine management systems and is sometimes used for tuning factory 
systems where factory fitted airmass meters were thought to be “restrictive”.  This strategy works well 
enough, but can be very challenging to achieve good results across a wide range of conditions.  Any 
changes to engine performance such as camshaft, cylinder head, or exhaust system normally require 
a complete retune. 

Alpha-N based systems simply use the position of the throttle plate(s) for load reference.  This setup 
is primarily used in racing situations with only normally aspirated engines that require very little low 
speed drivability.   

Mass air based systems are most commonly used by original equipment (OE) manufacturers 
because they implement a sensor that directly measures the actual mass of air that is entering the 
engine.  By knowing the mass of air flowing in, the engine management computer (ECM, PCM) can 
very accurately deliver the proper amount of fuel for any load condition in a wide range of 
environments.   
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Software overview 
Key elements of the software main screen are shown in figure 1.  These components will be 
referenced throughout this manual. 

Figure 1: Main Screen 

Drop down menus 
Drop down menus near the top of the screen (circled in  

Figure 1: Main Screen) work just as any other software application – clicking File, Edit, DBX, or Help 
each drop down a list of options to choose from.  Each is described briefly below. 

“File” menu contains New, Open, Save, Save As, and close which all refer to DBX project operations.  
Exit is at the bottom of the list to leave the software. 
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“Edit” menu includes Project…, Match…, and Meter… for editing each of these items.  When 
selected, each will launch a dialog box (separate, new window) to work from.  Editing all of these 
parameters is covered in this manual. 

“DBX” menu items: “options” selection opens box for COM port selection, “connect” starts PC to DBX 
communication (if not already started when the software was launched). 

“Update EEPROM …” sends the currently opened project to the DBX meter and is the similar to the 
“Write DBX” button in the “DBX communication” area in  

Figure 1: Main Screen. 

“Retrieve EEPROM …” gets the table that is currently loaded into the DBX meter and selected by the 
10 position switch on the meter. 

“Terminal” is a function not typically used by the end user. 

“Help” menu items include “Contents” and “Topic search” to assist in finding coverage of software 
topics.  “About” opens a small window with the current software version that is running and also the 
serial number of the DBX meter connected (or last connected if now removed). 

Meter Output Selection 
The meter output selection (pointed to in Figure 2: Meter Editor Buttons) is a pull down menu that allows 
for the choice of which output that has been already assigned in a project will be shown in the Meter 
voltage table and Meter output graph area.  This selection also defines which table in the DBX is 
“read” or “written” with the DBX communication buttons (unless the “Show All Options” checkbox 

below the drop down menus has been 
selected).  The DBX meter itself includes a 
10 position switch at is used to select 
which output voltage (or frequency) curve 
will be used for meter output.  Switch is 
shown in photo. 
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DBX Communication buttons 
“Read DBX” button is used to read output tables that have already been written to the DBX meter.  
The table read into the software from the meter is the table number selected in the Meter output 
selection pull down menu.  Meter output voltage (or frequency) is displayed in the Meter voltage 
output table numerically and as an output curve in the meter output graph area.  This topic covered in 
Meter Communication section. 

Meter Editor Buttons 
Meter Editor Buttons (circled in Figure 2 as “Meter editors”) launch a dialog box that allows for point 
by point meter output table adjustment or the ability to create a meter output table from scratch.  This 
topic is covered in meter output editing. 

Figure 2: Meter Editor Buttons 
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Creating a new project 
The first step toward programming a DBX meter with the DBX software is opening or creating a new 
project.  A project contains all of the information that will ultimately be programmed (or “written”) to 
the DBX meter. 

By selecting the “File” drop 
down menu and clicking 
“New”, a Project Setup 
dialog box will open as 
shown in Figure 3: Project 
Setup.    

The Name and Description 
of the project can be any 
string of characters desired 
to describe the project 
being created – they are 
not used in the filename 
when saving and 

reopening the 
project. 

 

Selecting Input Meter 
The “Input Meter” pull down menu is used to select the DBX meter that is being programmed.  This 
will define the base voltage to airflow characteristics that all of the output voltage and/or frequency 
output curves will be “matched” to.  It is very important to select the correct input meter at this 
point.  The meter editor button is used to modify meter voltage output values and is not used for input 
meters. 

The meter pull down menu will show all available meters in a particular folder – folders are selected 
with the “Folder navigation button”.  Clicking this button will open the Input Meter Folder navigation 
dialog box shown below.  It is important to note that the folder selection needs to be double clicked to 
indicate that this is the folder to be used.  For input meter selection the DBX folder should be 
selected.  After ensuring that the correct folder is shown as “open”, click the “OK” button to return to 
the Project Setup dialog box.  Figure 4 shows the result of double clicking the DBX folder. 

Figure 3: Project Setup 
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Figure 4: Input Meter folders 

In Figure 3, the “Units” selection options allow for a choice of English or Metric units.  English units 
will be displayed as Lb/hr while Metric units will be Kg/hr or Grams/sec.  The “Group” selection needs 
to be set to Ford currently for proper project setup. 

 

Once all of the project setup parameters have been set, clicking the 
“OK” button will save all of the input parameters and launch the 
“Confirm” window.   

Selecting “Yes” will launch the “Meter Match Dialog” window to start 
the next step of selecting meter output calibration curves to write to 
the DBX meter.   
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Selecting Output Meters 
Output meter selection is used to assign 
particular meter output values for a given 
mass of measured air.  Several output 
meters are available and are automatically 
stored on your PC when the DBX software 
is installed – folders “Ford”, “GM”, Import” 
contain several meter output tables to 
choose from.  

By clicking the down arrow of the Output 
meter pull down menu, all of the meter 
calibrations available in a particular folder 
can be shown for selection.   

 

To change folders, Click the “Set Folder” 
button in Figure 5and choose folder as 
shown in figure 6 and 7.        

 

     

     

Figure 6: Output Meter Folder selection 

Figure 5: Output Meter Selection 
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Once the meter is selected, the Vin and Vout values will be shown and can be assigned to one of 10 
tables to be written to the DBX later. If our example meter was detecting 13.5023 Kg/Hr through it, its 
unmodified voltage output would equal .5409.  Since the meter output has been “matched” to a 94-95 
Cobra 36lb injector meter, the voltage output will equal .3516 instead.  Example in next figure – the 
scroll bar on the table is used to view the entire table. 

 

Figure 7: Meter Match 

Clicking the “Assign to Table” button will store the chosen meter to the table selected in the Table 
assignment pull down menu.  The remainder of the output tables can be assigned now or at any time 
later by launching this dialog box.  Selecting “Edit” and “Match” from the main drop down menus will 
bring this dialog box back up to add or change all of the various table assignments.  The “close” 
button will save the tables to the currently open project and return the software main view. 
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Show All Outputs 
After assigning each of the meter outputs to desired tables (or DBX switch positions), the “Show All 
Outputs” box can be checked on the main screen to see how each mass flow of air will correlate to 
each output switch position on the DBX meter.  See Figure 8. 

 

Figure 8 Show all 
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Meter Communication 
Now that input and output meters have been defined, they need to be written to the DBX meter.   

 

Figure 9: Meter Communication 

Writing a single DBX table 
Once the “Write DBX” button is selected, a Progress bar shown in the next figure will begin to count 
up the amount of meter programming finished.  This will only write the one of the 10 tables to the DBX 
– the one selected in the “meter output selection” pull down menu pointed out in Figure 2.  The 
“Abort” button will stop programming if necessary and also displays the current table that is being 
written.  The meter switch position button “Switch: x” indicates the current position of the table 
selection switch that is located on the meter.  Clicking the button provides an instant update and is 
useful when it is difficult to see the switch directly due to mounting location of the meter. 
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Figure 10: Read/Write DBX 

Reading a single DBX table 
In order to retrieve tables that have been written to the meter, the “Read DBX” button shown in 
Figure 9 can be clicked.  This will retrieve the table from the DBX that has been selected in the 
“meter output selection” pull down menu pointed out in Figure 2.   Once selected, a dialog box asking 
for confirmation of this action is “ok”- click “yes” to start the read process and the progress bar will 
count up to completion. 
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Reading / Writing all DBX tables 
By selecting the “Show All Outputs” check box, all of the defined tables can be read or written.  All 10 
tables do not need to be defined to do this – any number of tables that have been defined can be sent 
to the DBX or read from the DBX.  Figure 11 shows the main screen after selecting the “Show All 
Outputs” checkbox.  From this screen, the “Read DBX(all)” and “Write DBX (all)” buttons work just the 
same as in the single read/write descriptions, but now will send or receive all tables in one process.   

 

Figure 11 Show all meters 
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Project File Operations 

Saving an open Project 
After creating a project and programming (writing) the DBX 
meter, the project should be saved on your PC for future 
reference of modification if necessary.  Clicking the “File” 
drop down menu will open the menu list shown in Figure 
12.  Clicking “Save” will save the currently open project with 
the exact same name as it had when opened (or created if it 
is new).  Choosing “Save As” will allow the project to be 
saved with a new name.  This can be very useful when 
trying something “new” with meter calibration so that the 
previous project can be reopened if the “new” one does not 
work out as planned. 

 

 

 

 When “Save As” is selected, the box 
in Figure 13 will open.  The folder 
where the software is installed will be 
the default location for Project files.  
Project File extensions are .DBX. The 
example in Figure 12 shows an already 
saved Project called “Demo” and one 
called “ProjectName” that will be saved 
once the “Save” button in the lower 
right is clicked.  Ensure that the File 
name includes .DBX before clicking the 
save button. 

 
 

Figure 12: Save, Save As 

Figure 13 Save as window 
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Opening a Project  
To open an existing project, the “File” 
dropdown menu is selected, and then 
the “open” option is clicked.  This will 
open the window shown in  

 

.  A single click on any of the .DBX 
projects shown in the window will place 
it in the “File name” line where it can be 
opened by clicking on the “Open” 
button.  A double click on the project in 
the list will do the same. 

 

 

Figure 14: Open Project 
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Meter output editing 
Another feature of the DBX software is the ability to edit existing meter output tables and also create 
your own custom tables from scratch.  Meter output tables can be adjusted on the DBX software main 
screen by direct table entry and use of “sliders” or by opening a “Mass Air Meter Editor” window.   

Main screen entry and “sliders”  
Meter output values may be changed to suit tuning needs in the main screen by typing values into the 
“Meter Output Table” or clicking and dragging “Adjustment Sliders” shown in Figure 15 up and down.  
The meter edited is shown (and can be changed) in the pull down menu indicated in Figure 15. 

 

Figure 15 : Main screen meter edit 

To change output table values directly, simply click on the box that holds the value to be changed and 
type in a new value. The change will show in the table and the graph in the middle of the screen.  
Using the sliders to change the voltage curve is a very graphical and intuitive way to add or subtract 
meter output at various points along the curve.  This can be very useful for fine tuning a meter’s utput 
for a specific engine setup.  When used in conjunction with a dyno and wide band air/fuel monitoring, 
very precise tuning can be accomplished.   
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Figure 16: Sliders 

By clicking and holding the left mouse button, the sliders can be “dragged” up to increase meter 
output at particular points in the curve or down to decrease it.  Example in Figure 16 shows the slider 
background colors change to indicate higher or lower output values. The changes made to the sliders 
are shown on both the graph and the numerical output table.  “Slider Sensitivity” underlined in Figure 
16 is used to control the amount of change that occurs as sliders are moved – “1” would allow very 
small changes to the curve for large slider movement whereas “10” moves the output far more for the 
same amount of slider movement.  “Reset” button is used to zero all sliders to starting point. 

Other meters in the open project can be altered in the same manner by using the “Meter Output pull 
down menu” and selecting any of the meters that were assigned to the project.  The modified meter 
outputs will only be saved in the currently open project and will not overwrite the original meter files 
that they came from. 
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Mass Air Meter Editor 
 

The “Mass Air Meter Editor“ window can be used to view and modify DBX 
output tables.  Clicking the “Meter Editor” button shown in Figure 18will 
open the Meter Editor window shown in Figure 19.  The Meter Editor Button 
is available on the software main screen, the “Meter Match Dialog” window 
shown in Figure 7, and from the “Edit” dropdown menu of the main 
software screen by selecting “meter” from the list. 

 

Editing a meter in the “Mass Air Meter Editor” window is achieved by simply typing Mass air flow and 
voltage values into the Data Table’s “Flow” and “Volts” column.  A frequency based meter will have 
“Freq” in place of volts.  Changes to “Meter Response” (the amount of voltage or frequency output for 
a given mass of air) are shown in the Meter response graph.  The Data Table and Meter Response 
curve can be seen in Figure 19.  “Part Number” and “Description” fields may be changed by 
highlighting text and typing new name and part number. 

Figure 17 : Meter Editor 
Button 

Figure 18: Meter Editor Window 
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Clicking on the “File” drop down menu from the “Mass Air Meter 
Editor” window and selecting “open” will show all available 
meter folders on your PC.  Example Error! Reference source 
not found. shows the result of double clicking the “Ford” folder.  
Any existing meter in the “open” window can be selected and 
modified.  It is always a good idea to save modified meter 
output tables with a new name in case you need to return to the 
original.  This is done with the “save as” option from the “File” 
drop down menu.  This will be the same window as Figure 13 , 
but will save the meter as a .maf type file.   

 

 

 

Figure 19 
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Other options in this file drop down menu are the Import and Export 
options that allow the saving and reloading of meter data in a .XLS 
(Microsoft Office Excel spreadsheet) format.  This can be very 
useful for graphing several curves at the same time or bringing 
meter curves in from other tuning software.  With over 100 data 
points available, it’s possible to very accurately match any meter 
required. The import and export file operations are also very helpful 
when creating meter output curves from scratch which is covered in 
the next section. 

 

Create your own meter  
By selecting the “New” from the “File” dropdown menu in the “Mass Air Meter Editor” window, an 
entirely new meter can be created.  A new meter is assigned a Part Number and Description by 
simply typing each into the fields provided. The “Type” of meter is selected by choosing from the 

available options in the “Type” pull down menu.  “Units” can be selected 
as “English” or “Metric” based on user preference or the data available.  
Metric units can further be viewed as Kg/Hr (Kilograms per hour) or 
G/Sec (Grams per second) and English units may be displayed in Lbs/Hr 

(pounds per hour) or Lbs/Min (pounds per minute). 

  The Data Table is 
completed by typing 
volts (or frequency) 
in the left column 
and airflow in the 
right column.  Once 
all of the 
components of the 
new meter have 
been entered, the 
“Save As” selection 
from the “File” menu 

is used to provide the new meter with a filename for future recall. 

 

Figure 21: Create New Meter 

Figure 20 
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Advanced Features 
The DBX meter software also allows some advanced options for meter output signal conditioning 
(smoothing) and specification of air temp sensor type.  Clicking the “Advanced” button on the main 
screen (circled in Figure 23) will launch the “Advanced” window for editing.  This button is also 
available in the “Meter Match Dialog” window (see Figure 7). 

Set Air Temp sensor type  
The air temperature sensor output for the DBX meter can be changed by clicking on the type of 
sensor desired – currently “Ford” or “Other”.  Changes made here affect the currently open meter only 
and not all of them.   

 

Figure 22 
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Signal output conditioning 
The meter output signal conditioning variables (Figure 23) can be used to change how the DBX 
meter interprets “real” fluctuations in airflow vs. “turbulent noise”.  Due to the nature of airflow 
measurement, it is necessary to “smooth” out the signal being generated by the sensitive sensors 
located in the DBX meter.   The DBX meter is constantly taking far more samples internally than it is 
sending out and processing them for the most accurate reporting of airflow possible. 

The dampening variable will affect how the background process in the DBX meter will “average” the 
output samples.  Numbers can be entered directly into the Dampening input box, or the up and down 
arrows may be used to increase or decrease the Dampening value.  Higher dampening numbers will 
“slow” down or “soften” meter response and can be useful for installations where there is steady flow 
turbulence due to intake pipe bends, filter placement, etc.  The default value of 4 will work best for 
most applications. 

Noise threshold values can be adjusted to change how the DBX meter reacts to very quick changes 
in airflow.  The DBX processor will allow a very large, rapid change in airflow input value to “bypass” 
the smoothing process assuming that it is due to a “real” condition such as fast throttle movement.  If 
very large, fast changes were averaged into the rest of the output samples, it would be likely to cause 
a lean throttle “tip in” problem.  If lean air/fuel mixtures are seen during rapid throttle application, the 
Noise Threshold value can be lowered to allow for smaller dynamic airflow changes to bypass the 
averaging process.  Noise Threshold values may be altered by typing a new number directly into the 
“Noise Threshold “value box or using the up and down arrows provided in the “Advanced” window.  
The default value of 3 should be used unless reliable data suggests otherwise. 
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